
                                                                                                    

                        INTERLACING   SCRIPTS   
                    for   LENTICULAR   LENS

 N O T I C E  LENTICULATOR v. 5.6.3

Warning  : This notice explains HOW to use the scripts to interlace pictures for lenticular imaging.  
         IT IS NOT a course on lenticular imaging.

The following takes for granted the reader already knows the basics about lenticular 
         pictures, and is quite familiar with Adobe Photoshop ®.

Let us recall to start with that interlacing is made for a determined number of lenses.

Lenticulator is made of five distinct parts - with a BatchRun possibility - and offers Tools.

The first part will produce the high resolution “MasterFile” digitally interlaced in which each 
part of the picture representing one lens is composed of a flat number of pixels. This Masterfile will 
be valid for the determined number of lenses of ANY lenticular sheet . The interlacing does not take 
care of the particular lenticular sheet that will be used, but only of the account of lenses that will be 
used on that sheet. The resulting MasterFile is to be saved. 

The interlacing is resolution-independant, affords any number of layers, and the files can be 
Grayscale, RGB, or CMYK.

The second part is optional - you can skip it and proceed directly to the third part - and enables 
to add optical targets to the Masterfile. This helps precise positionning of the print if you adhesive it 
to a lens and also precise monitoring of the centering of the phase if you use direct printing as with a 
flatbed..

Third part resamples the MasterFIle to the OutputFile. A previously saved MasterFile can at 
any time be resampled according to a new pitch.

This is very convenient if you have to start a print over again simply because you need to slight-
ly adjust the pitch : the interlaced Master remains valid, all you need is to proceed to a new Output 
resizing after entering the new pitch.

The fourth part is optional and enables to add skewing lines on the side of the print, so as to 
have an easy placement of the sheet on to the print and avoid cross-stepping.

The fifth part is dedicated to those directly printing onto the lenticular material with a flatbed UV 
device. After miroring and rotating, the application seperates and saves the document in two files : 
a “Target” file is to be printed onto the tabletop for registration of the lenticular sheet, and a “Picture” 
file is the finished artwork to be printed.

Lenticulator works RGB, CMYK, and Greyscale, with no size limit and no number of layers limit.

Henri Clement - l'Imbricateur Lenticulator Notice



                                                                                                    

- 2 -

There are also four additional Tools you will find in the Window menu : < Show Tools > , 
 which enable to :

- Count the number of layers, 
- Displace the Key plane, 
- Repeat actions,
- Build an anaglyph.

For the digital interlacing process, you will need what is contained in folder :
 < Lenticulator 5.4 >, which details in easy steps the necessary installation.

Requirements :

• Mac OS X version 10.6 or higher
• Intel processor with Photoshop CS3, CS4, CS5, CS6, or CC.

Please note :
- For CS3 and CS4 working on an Intel processor, update the Adobe Unit Types.osax to     ver-

sion 2.1.0. by following the Instructions described in “Solution 1” of the following link :
http://kb2.adobe.com/cps/516/cpsid_51615.html

For CS5, update to V.12.0.1 is compulsory.

For Mac OS Mojave, dont forget to activate Lenticulator in the Privacy —> Automation folder.

1° Installation  (MAC)

- Double-click the pack and follow instructions. Install.

  If you interlace for lenticulars quite often, it will be convenient to place the alias of the 
application in the Dock, for instance next to Photoshop’s.

There is no need to restart

On first opening, the software will ask you for a Password or a KeyFile to drag & drop into the 
window; This is the “.....lentlicense” document you will find in the folder. Drag and drop it to the win-
dow.

The software is straightforward operational.

The free evaluation license is usually for a three-months trial. At the end of the trial period, you 
will be invited to purchase a permanent license from us. 

 
                           

Henri Clement - l'Imbricateur Lenticulator Notice

http://kb2.adobe.com/cps/516/cpsid_51615.html


                                                                                                    

- 3 -

                         2° Picture start-up

1 - Once the creative artwork achieved, in order to interlace, your 
picture must be prepared in layers in one Photoshop file. All the 
different views must be in layers as a movie-like sequence all 
atop one another, at the same size. For instance, for a 20 image 
picture, you will have 20 layers, which you will now have to or-
der the following way: 

Move the layers as to place at the bottom the picture 
seen from outmost right position.  Above it, you will place the 
picture looking immediately at its left, and so forth ...        
You will end with top layer being the vision of leftmost eye.

Notice : You can keep Adjustment Layers on top (Levels, Curves, 
... ) but these will be lost in the interlacing process. So save the 
settings so as to be able to load these back after interlacing.

For instance, for a twenty-five image-picture, the Layer 
window should properly show 25 layers from bottom to top with 
pictures displayed from right to left vision.  

                                                               It looks like this :   —>

  Make sure no layer is locked, as this would stop the script. 
If you see a padlock icon at the right of a layer, unlock it.
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  First Part : Interlacing

Click the < Interlacer > icon : a menu opens     
asking you to fill in the number of lenses the 
output picture is expected to cover.

(  This is:  expected output in inches x relative 
pitch, rounded to nearest full number )

Choose Number of source layers ;           
you can fetch the information directly by 
                      clicking the < Get > button 

Choose if the the lenses are to be 
horizontal (back and forth animation) or vertical 
(3D and left to right animation).
       

Default setting has a “sharper” box active. 
This is more specially meant to improve the quali-
ty of 3D pictures (with depth). We recommend to 
uncheck the box for “flip” type pictures. (You may 
want to experiment later comparative prints to see 
the difference.)

A Master interlaced file will be saved. 
Default name is <Master (number of layers).(number of lenticules)>
( N.B.: Note that if you multiply these two digits, you get the width of your file in pixels.)
You can change the name if desired and choose destination. If you want to restore the default name, 
activate the line and click the Tab key.
  

 If you want an easy calculation of the   
number of lenticules occupied by the picture, you 
can use the Assistant: open a new text field by 
clicking the bottom thumbnail.

Enter the Relative Pitch you have          
measured. Enter your Output Size.

If the size is correct in Photoshop, 
you can click the “Get” button and the 
application will go and fetch it for you.

Read Theoretical Result, check rounded  
value on top box is OK for you.

You can adjust Number of lenticules to  
whatever you want (works with Up and Down   
arrows also), resulting size shows up accordingly.

- That’s all. Click < Interlace >.
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After accepting, Interlacing is launched. Everything is working background. After a start-up 
process, percentage indicates progress of work.

At the end, Photoshop reappears on desk with finished interlaced picture.

Note all this process is resolution and size independent. There is no limitation in the 
number of layers, nor in the size of pictures, nor in the number of layers.

Finished interlaced file appears normally as a squeezed, anamorphosed picture, 
since it is made of full pixels. This is the MasterFile you will start from to produce the printing file for 
different outputs. You dont necessarily have to perform this right away, you can do this at any time 
afterwards.

After interlacing, Lenticulator does not quit, but waits in the Background.
If you had Adjustment Layers prior to interlacing, you can call them back as they were deleted in the 
interlacing process.

Second Part : Adding targets ( optional )

Click the “Targets” icon. 
Choose the height of the targets 

you wish added to final picture.
Click “ Add targets “

The result is a new layer behind 
main picture, with target centered on 
the middle of central lens. If your 
phase is not meant to be centered, 
you can now displace the target layer 
left or right to adjust phase accordingly 
(Displacement Tool using the left or 
right Arrow).

Save this again as MasterFile. 

The targets are an optical magnifying array enabling you to register very precisely your print on 
the lenticular sheet. It displays as a red target you have to center between two white bands by sight. 
What you see intuitively shows if you have to slide print left or right. When you are precisely adjusted, 
a black line appears bold in the center.

The Target is on purpose on a separate layer : if your pictures has a non-centered phase, you 
can displace the Target sideways to a new focusing point. 

For direct flatbed printing, set the Height here simply to zero. You will print the Target alone as 
template on the bed.
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Third Part : Resizing for Output

MasterFile needs to be resized appropriately for printing depending on the precise pitch of lens.

Click the Resampler button.

Fill in the text fields :

- Enter in cm the Output Height you need 
for the print, targets included.

 - If the height was previously correct in the                             
Photoshop file you can just restore it                               

  by clicking < Get > :

- Enter the best Relative Pitch 
(expectedly precisely measured with 
a Pitchchecker )

- Enter the number of lenticules 
covered in the Masterfile. 
( or check it is correct )

- Check resulting Output Width is credible.

- Enter your Best Output Resolution.

- If your RIP or Output system can manage 
rectangular pixels
(x = 100%, y = 200% or 400%), activate “Anamorphosis” 2x1 or 4x1. 
(This is the case for people printing with Epson printers for instance. 
At 2x1, the resulting Output file is simply half the weight, for exactly the same final result.)

- For an adhesived print, you can merge down the file : activate < Flatten Document > ;
- For a direct flatbed print, keep the Target on the seperate layer : dont click <Flatten Document>.

Click “Resample”.   Result is Output File.

N.B. Some filmsetter operators will find it better to directly feed the MasterFile to the RIP, thus      
avoiding the resampling in Photoshop. You would make comparative tests to experiment best        
output results on your specific material.

Resizing a previously calculated Masterfile :

- Open the Masterfile in Photoshop.
- Go directly to the Resampler tab. Fill in the text fields.
- Resample.
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       Fourth Part :  
       Add Skewing Lines

Skewing Lines help to avoid cross-stepping 
when positionning the lenticular sheet on to 
the print.

Optional, but compulsory if you are                 
hand-adhesiving the prints. 
This enables you to add black lines on the left 
and right-hand side of the print. Lines are 1/6th 
of a lens by default setting, but you can change 
these.

Enter “Skewing Lines”.
Fill in text field.
Choose the margin you want.
For Direct flatbed printing, enter zero.

Resulting file will be saved. Default name is :
< (Lens resolution = Relative Pitch) lpp.(Number of Layers).(Number of lenticules) l > 
Modify if you like, choose destination.

Add.
For an adhesived print, file is ready for   
printing.

You can choose the width of the line from 
1/6th of a lens to a half lens.
This can be repeated several times if you 
want more lines.
If you add several lines, you can change the 
width each time if you like.

For flatbed printing, be sure to have the 
Target layer activated so as to add the Ske-
wing Lines on that layer.

          +++++++++++++++++++++++++++++++
* Glossary :

- Relative pitch : This is the pitch you measure at expected viewing distance.

- Best Output Resolution : This depends on the internal mechanism of the output device you will use. For 
instance on an EPSON inkjet, use 720 ppi for a 2880 dpi output. On film-setters, you have to ask or go and 
find in some remote page of the notice which is the real internal resolution of the film-setter. Can be a flat 3 
000 or some awkward figure like 4 876. ALWAYS use a sub-multiple of this internal resolution.
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      Fifth Part :  
          Direct Printing

      mainly for Flatbed UV Printing

Here are the points to follow specifically for flatbed UV printing :

- Targets : choose Height = 0 cm, 
then Save Master over again ;

- Resize : dont activate “Flaten 
Document”

- Skewing Lines : Marge : 0 mm

- Activate “Mirror”

- Activate “Offset” rotation
               (usually we use 7°).

- this final print will be saved,    
as well as a twin <Target File> . 

- Default name is :
< Print (Relative Pitch) lpp.(Number of Layers) i.(Number of lenticules) l.tif >
You can modify name if you wish and choose destination. A seperate <Target> file will also be saved. 
This file displays exactly the same pixel-size as the Print file.
At the end of the processing, both files display on the screen, for final check-out.

Print the “Target” file, either directly onto the table top, or onto a light paper scotch-taped into place just at the 
necesary space. Beware NOT to untape the paper once printed.
Then register the lenticular sheet by sight placing it onto the tabletop. The Skewing Lines show precisely 
where you have to place the sheet, and the full central target enables an easy registration : you sould see 
standing above the symetrical targets with a bold black line in the center, all the way from top to bottom         
( A high stool or step ladder is compulsory ).
You will improve the focusing for registration by slightly uplifting the lenticular sheet untill it is perfectly in place.  

Batch Processing :

If you know in advance precisely all the 
settings you are going to use, you can 
set these in all menus to start with. 
Then go to Window —> Show Batch-
Run. 

A menu lets you choose some or all 
menus you want to process. 

<Run> starts the Batch processing.
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< Tools >   NOTICE

From Lenticulator application, go to Window —> Show Tools.

Count Layers : enables to count the   
number of layers of your stereoscopic 
sequence. No interest when you have 
twelve layers, but gets really handy when 
you are up to more layers than what fits 
in the Layer Window, and you have to 
scroll down the list to count ...                
The application  will not count adjustment 
layers.

- K-Shift : enables, on a stabilized sequence, to adjust the Key axis or plane by moving it forward or 
backward in the layout. Enter in pixels the amount of the displacement you want to apply to each 
layer.

- A positif digit will back up the 
Key in the layout, which will       
advance the layout.

- A negative digit with bring the 
Key forward, which will back out 
the layout.

The best when possible is to find a 
detail in the picture that can be 
used at the same time to stabilise 
the composition and act as Key 
axis or plane. You benefit then of 
both adjustments in the same   
operation. Odds are many times 
there is no detail you can find in 
the picture which is at the right 

depth to be used for the Key point. Then you have to first perform the stabilization as best as       
possible, then adjust to the right Key by displacing the layers with this application.

- If you are using a panoramic travelling platform, with a fix right-angle camera, the Key is a 
plane, and you can choose any peculiar detail in the picture ;

- If you are using a converging (toe-in) system, then the Key is an axis, and you have to find a 
point as close as possible to a central vertical median.   
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- Repeat Action : enables to repeat over again any Action you have prepared, any number of times. 

Simply Fill in the text fields of the “Repeat Action" window : write in the exact name of the     Action, 
as well as the exact name of the Set.

Fill in the text fields of the “Repeat Action" window :
In “Iterations", put the number of layers. Start. 

Most of the time, you end up having a lenticular sequence topped by 
adjustment layers - with or without masks - and/or template layers 
(such as types or logos) you need to add in the layout. The "Appli-
quer" action furnished here will do that. Here is how to use it : first im-
port into Photoshop    "Lenticulator.atn"  from the Actions window —> 
Load Actions.

The template layer will be applied to all layers, one after the other.

The same application will easily enable to put types or layers 
on a different depth than the Key plane, forward or backward, simply 
by adding an x-wise transformation instruction in the Action.

                         Here is an example with a 25-layer picture :

Place at the top the layer you want to merge to all layers.

Note the number of 
Layers in “Iterations”,
Start.

End by discarding the 
last bottom layer.
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- The Anaglyph Tool :

In the Layers window, activate the Eyes of just the two layers you want to test.
(Check other Eyes off.)
 
Click Start

“Black and white” option box will deliver a black&white anaglyph - usually a better deal.

Once done, if this was just for checking, you can retrieve former state by moving three steps back in 
History.

Please feed back any issue you may encounter using this software.

Development : Henri & Thomas CLÉMENT       
       ( e-mail : limbricateur@free.fr )                           
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How to Make a Pitchchecker

1° Make a Pattern : 

- Make a New Document, such as  40 x 40 pixels.
- Make a rectangular selection 8 x 40 pixels on 
the very left of the picture
- Fill using the bottom Red in the Colour 
Picker :
- Move the selection 8 pixels to the right ;
- Fill using the next colour by moving up the 
slider, such as a nice yellow.
- Move the selection 8 pixels to the right ;
- Fill using the next colour by moving up the 
slider, such as a nice green.
- Move the selection 8 pixels to the right ;
- Fill using the next colour by moving up the 
slider, such as a nice blue.
- Move the selection 8 pixels to the right ;
- Fill using the next colour by moving up the 
slider, such as a nice purple.

You now have this little 
square made of five 
distinct colours : 

- Go to Edition —> Use as Pattern... —> Name of Pattern = Save such as < 5c.x 8 px.tif >

2° Make a MasterFile :

- Decide the size of the final pitchchecker. For example, let's make a 21 cm wide pitchecker for 50 lpi material.
- Calculate how many lenticules will fit in the distance : 21 cm = 8,268 inches

50 lpi x 8,268 inches = 413,4 lenticules
Let's round to 410 lenticules.
- 410 lenticules x 40 pixels = 16 400 pixels.
- Make a New Document, Name 40 px-210 l.tif, Width 16 400 pixels, height 100 px, Res whatever (600 ppi is 

OK), RGB. OK  
- Go to Edition —> Fill... —> using Pattern and choose the pattern you have just made
- Save As < Master 40 px-410 l.tif >

3° Build the Pictchecker :

Let's make a pitchchecker ranging from 49,9 to 50,02 for 
example. 
- Open Lenticulator
- Go directly to Resampler
- Fill in the textfields :

Output Height : 1 cm
Relative Pitch : 49,9 lpi
Number of lenticules : 410
Ourput Resolution : 600 ppi for HP and Canon

720 ppi for Epson
Anamorphosis : None
Click Resample

- Image —> Duplicate As < 49,9 - 50,02.tif >
- Save
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- Go to Image —> Size of Canvas
- Leave Width at 20,87 cm, put Height to 13 cm, place Position on upper central box. OK.
- Activate layer selection (Command-click on the layer name in the Layer Menu)
- Go to Edition —> Contour... and make a 3 pixel black contour.
- Activate Text tool. Write a nice bold < 49,9 > on the left end of the bar. (Usually Arial Bold is good)
- Revert to "Master 40 px-210 l.tif"
- In History, revert to initial state;
- Go to lenticulator. Switch Relative Pitch to 49,91. Dont change anything else. Resample
- In the Layer Menu, Duplicate to "49,9 - 50,02.tif"
- With <Command-T>, raise the bar -5 cm so as to place it directly beneath the first 49,9 bar.
- With the TextTool, add <49,91>.

At present your picture will look like this (blow-up of the upper left corner) : 

you can see the  49,91 bar is very slightly smaller than the 49,9 bar. Continue :

- Revert to "Master 40 px-210 l.tif"
- In History, revert to initial state;
- Go to lenticulator. Switch Relative Pitch to 49,92. Dont change anything else. Resample
- In the Layer Menu, Duplicate to "49,9 - 50,02.tif"
- With <Command-T>, raise the bar -4 cm so as to place it directly beneath the second 49,91 bar.
- Go to Edition —> Contour... and make a 3 pixel black contour.
- With the TextTool, add <49,92>.

and so forth, untill you have totally completed the chart to bar 50,02.

Once finished, add a bold black vertical line in the very middle of your pitchchecker, 4 px wide.
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The finished pitchchecker should look like this : 

Print on glossy paper, lenticules vertical.
Dont forget to use the 2 400 dpi setting if you are using an HP or Canon printer, 2 880 dpi if you are using an 
Epson, and print in one direction.

Once you have the print :
- Place the pichchecker on an even perfectly flat table.
- Place the lenticular sheet on the print ; get it straight using the bold black line that is in the middle of the print.
- Have the lenticular sheet as flat as possible pressed onto the print - I use leads dispatched around the sheet 
to hold it pressed flat.
- Place yourself at the distance you will want to see your final output print.
- Read the line that displays one even colour throughout - whatever the colour. 

Note the number, that’s the Relative Pitch.

***********************************************************

Using the same system, and simply by changing the data appropriately, you can make you own              pitch-
checkers for any lens, any size, any resolution step, any band width which you will consider be best for rea-
ding.
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1. Does it matter what the ppi of the original PSD file is? 

The whole interlacing scripts are absolutely resolution independent - they work strictly regar-
ding  pixels - so ANY resolution can be decided for, it doesn't matter. As well as the scripts work be it 
GreyLevel, RGB or CMYK originals. Just CMYK being heavier will take up a little more time. 

2. How do I create a 2 phase flip ? 

A flat two-layer pattern is never used. Usual encounter with a two-image flip should be regar-
ded at least as a twelve image layout, which means you will use 6 times first picture, and then 6 
times second picture, and so build a 6 layer + 6 layer picture construction = 12 layers to start with. 
Example :

If you have two pictures A and B to make a flip, duplicate each layer for example six times (or more) 
to build at least a 12-layer sequence, such as
A + A + A + A + A + A + B + B + B + B + B + B
- then interlace. 

After first printing, you will probably notice the first picture will come to grow into the second 
picture's territory, and so will the second picture regarding the first. 

So then you will need to start building an intermediate picture, that will separate first picture 
from second  picture, and help having them really snap distinctively from one to another with lesser 
optical overlay. And so you can try a 6 + 1 + 6 +1 construction. On vertical-lens flips, you can even 
need commonly a 6 + 2 + 6 + 2 construction (= 16 layers) to enhance optical separation. On severe  
cases you can even try 5 + 3 + 5 + 3 ...

 Also, if you are on an exceptional flip that does not need an intermediate picture (after all, can  
happen) a higher number of construction - such as 8 + 8 or 10 + 10, depending on the lens used - will 
provide a snappier flip, with a much shorter transition from one  picture to the other - much nicer. 

3. For flips, what do you use for an intermediate picture?? Is this just a white layer? 

No, the intermediate picture is not a plain white layer. The intermediate picture is usually a  
composite built up from a mixture of parts coming from each original picture. Seen alone, its  usually 
very awkward. But its meant not to be seen in the final sequence. In fact viewer sees a  good flip wi-
thout even noticing there is an intermediate picture.

This is where the tricky part starts : in fact truly this is already artwork. So like artwork, its hard 
to explain once you're away from the canvas.

Thinking it over, I think there is no real rule for this. I easily test several, and start over again  
until I achieve something fluent on the prototype. Its a matter of feeling. 

My suggestion : Best approach is perhaps to start a plain 6+6 interlacing as described. Proof  
it, and look at the flip. Find out if anything is bothering you. If the flip does not pass easily and  com-
fortably, invent the picture you imagine you could put in between that would sooth the  problem. And 
proof again.

Each flip is most of the time an original affair. 

4. After inter-lacing for a flip, do you slightly rotate the image before printing it? 
If so, what amount do you rotate, and what's the technical reason for doing so? 

The purpose in operating an offet to the final print is to avoid banding - so if you are not expe-
riencing banding, you have no reason to bother with  this. 
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	 Two things can bring along this issue : 

- either it is an artefact in the final resizing operation from the Masterfile to the Output file. The ban-
ding is then in the pixel construction of the file. Luckily this very seldom happens.

- or it is built by the RIP which converts the pixel information of the Output file into inkjet dot infor-
mation for the printing machine. In this case, the banding is very well erased by adding an offset to 
the Output file. This is a very common fault we experience on almost all flabet inkjet UV devices - for 
which we have made now in the interlacer a dedicated part called “Direct printing”, because the pic-
ture is then printed directly mirror onto the rear of the lenticular material.

	 A direct straightforward print with these type of printers almost always display banding, arte-
fact which disappears completely by bring a 7° or 7,5° degree rotation to the final printfile. This is a 
rotation data we use by experience beacuse we know it works, but I invite users to experience on 
ther own : perhaps 3,5° will operate fine, depending on your machine. (feedbacks welcome !).


	 Personnally, I use the adhesived printing method using an Epson StylusPro, followed by lami-
nation, and usually experience no visible banding at all - so I print straight. But the practice seems 
compulsory for flatbed Inkjet UV printers.


Good work!
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